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Introduction 
These are instructions on how to create Crystal Reports for the TW WebCenter using 
the standalone Crystal Report 8.5 designer. (At the time of this writing I did not have 
access to Crystal Report 9.0 standalone designer.)  This documentation will show you 
how to: 

1. Create a DNS connection. 
2. Connect to the database thru Crystal Report 
3. Create a Crystal Report using the Report Expert 
4. Create report sub groups 
5. Add a chart to the report 
6. Add input parameters / new fields to the report 
7. Explain how auto generated input parameters are filled in WebCenter. 
8. Embed fields into label boxes 
9. Create a formula field 
10. Change the database connection after the report is created. 

The example in this documentation uses the TempWorks 7R4 version of the database.  
Lastly, this documentation will show how to create a Customer Spending report by 
department for the WebCenter.  

Database connection 
Crystal Reports has multiple ways to connect to a database.  The easiest way to 
connect to TempWorks is via a DNS connection. (The default DNS connection is called 
Tworks.)  To create a DNS connection (skip to next section if you already have setup 
DNS connection): 

1. Go to the Control Panel by clicking on “Start>Settings>Control Panel.” 
2. Select  “Administrative Tools.” 
3. Click on “ Data Sources (ODBC)” . 
4. A window called “ODBC Data Source Administrator” should popup. 
5. Click on the “System DNS” tab. 
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6. If “Tworks” does not exist, then create it by clicking on the “Add” button. 
7. Select “SQL Server” from the list and then click on the “Finish” button. 
8. Type in “Tworks” for the data source name. 
9. Select the Tempworks Database from the server dropdown. 

 
10. Click on “Next>”  button. 
11. The next page, displays what kind of security to connect to the database, it really 

does not matter.  Just select the default setting, which is Window NT 
authentication.  Click the “Next>”  button. 

DNS Name  

SQL Server 
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12. Now you want to change the default SQL server it connects to by checking the 

“Change the Default Database to:” and change the default database to 
“Tworks.” 

  
13. Click the “Next>” button. 
14. Accept the default settings again, and click the “Finish” button to test the 

database connection. 
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15. Click on the “Test Data Source..” button to make sure you can connect to the 

database.  Click on “OK”.  Now you are ready to create a Crystal Report 
 

Creating a Crystal Report using the Report Expert 
The Report Expert in Crystal Report reduces the amount of time to create a report 
because it creates 70%-95% of the report for you. 
To create a new Crystal Report: 

1. Start up the Crystal Report 8.5 designer.  It is normally located at: 
“ Start>Programs>Crystal Report Tools>Crystal Reports” 

2. If you just started the Crystal Report, select the “ Using the Report Expert” 
under the Create a New Crystal Report Document panel.  Click the “OK” button. 
(Otherwise, if you are have Crystal Report open, click the “New” toolbar button 
and move to the next step.)  
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3. A “Crystal Report Gallery” dialog should pop up. 
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4. Just select the “Standard” style.  Then, click on “OK”. 
5. The “Standard Report Expert” window should popup. 
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6. This is where you select how to connect to the database.  Click on the 
“Database” button. 

7. A window called “Data Explore” should pop up. 

 
8. Expand the “ ODBC” node in the tree view panel.  Then find the DNS connection 

name.  In this case it would be “TWorks.” 
9. If you expand the “TWorks” node, then you will see a list of all the database 

tables.  This is by default. 
Hint: To filter the table list or select a stored procedure to query from, click on the 

“ Options..”  button. 
·  To filter table names, type in the tablename in the field “Table name LIKE:” 

(For example, type in “tww_%” for all tables that start with “tww_”.) 
·  To display stored procedures, check the “Stored Procedure” box. 

To Filter tables 
or display 
Stored 
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·   
·  Click “Ok” to set filter options. 
·  Sometimes the filter will not automatically apply.  To apply the filter, close 

down the “Tworks” node and re-expand the node.  This should refresh the 
list. 

·   
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10. Select a table or stored procedure to work with by double clicking on the table or 
by clicking the “Add” button. 

 
Hint: Suggest that if at all possible to do the data querying in Crystal Reports instead of 

stored procedures because this would reduce the amount of files to keep track of.  
For example, to update a report, you would have to update both the Crystal Report 
and the stored procedure, instead of just the Crystal Report.  Use stored procedure 
for complicated queries and optimization. 

 
11. This will be sample of Total Spending by customer.  So add the following tables: 

a. ContactRoot – To retrieve the user’s CustomerID 
b. CustomerRelate – New table that gives all the department of a parent 

customer node. 
c. TxnsRoot – Total billing information for customer 

 
12. Click the “Next>” button (or the closing the “Data Explore” window) will bring your 

to the “Links” tab. 
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13. The “Links” tab will allow you to join the tables.  (If there is only one table 

present, the Report Expert will move to the “Fields” tab.) 
14. Remove all the auto-generated links by clicking on the “Clear Links” button. 
15. Now join the table by dragging and drop the fields.  Link the field like this: 

ContactRoot.CustomerID -> CustomerRoot.CustomerID and 
CustomerRoot.RelatedCustomerID->TxnsRoot.CustomerID. 
It should look this this: 

Clear all 
the links 
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Note: All default links are equal-joins.  (If you want to change it to a left or right 

outer join, then select the link and click on the “Link Options..” button.  
Select your join type under the “SQL Join Type” panel.) 

16. Click “Next>>”  button (or select the “Fields” tab) when you are finished joining 
the tables. 

Drag-n-
Drop to 
create 
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17. The “Fields” should allow you to select the fields that you want displayed in the 

report. 
18. Double click on the fields from the “Available Fields” or click on the “Add->” 

button to add fields.  Click the “<-Remove” button to remove fields to display. 
Tip: To save time, you can change the name of the column headers here by 

changing the name in the “ Column Heading.” 
19. After you have selected the fields you want displayed, click the “Next>>” button 

or select the “Group” tab. 
 

Add 
Fields 
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Change 
Display 
order 
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20. The “Group” tab will allow you to group the data. 
21. This is useful for report that requires sum fields.  For this example, we want to 

group by department so we will group it by department name. 
22. Click the “Next>>” button to move to the “Total” tab. 
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23. If you do specify a Group, you are allowed to have sub totals at the bottom of the 

report.  Thus the “Total” tab allows you to specify which columns to sum up.  By 
default, Crystal Report automatically sums up all number fields.  You might want 
to remove auto-generated identity fields from this sum total. 

 
Note: That the grouping name is a tab.  There will be one tab per grouping.  This 

will allow you to specify subtotals per major grouping.  
Hint: Crystal Reports allows you to perform functions other than summing up the field.  Look at the “Summary Type” 

dropdown for more selections. 

 

24. Click the “Next>>” button, and it will bring you to the “Top N” tab. 
25. The Top N tab will allow you to sort the groups by the summary totals. (Very 

optional).  To ignore it, click the “Next>>” tab again. 
26. This should bring up the “Chart” tab. 

Grouping 
field 
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27. The “Chart” tab allows you to add a chart to the report.  Adding a chart to the 

report makes the data more readable.  Charts are not that difficult to add. To 
setup a simple chart: 

a. Select a chart type to display.  For this example, select a “Bar” graph. 
b. Click on the “Data” tab to specify what data to display. 

i. Crystal Reports tries to make the creation of charts as easy as 
possible.  If you specify a group, Crystal Reports will automatically 
create the X-axis from the grouping information and you can select 
the Y-axis from the total information. 

Specify the title 
and axes 
labels. 

Select what 
data to 
display 
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ii. “On change of” is the X-axis display.  The “Show” is data displayed 

along the Y-axis. (For this example, change the “Show” to be the 
sum of TotalBill.) 

iii. If this not exactly what you want to display, then click on the 
“Advance” button under the “Layout” panel. 

Simple 
group. 

$ � %� �� �&	 �� � � � � � � � � " �
	 � �� ' �

Y-Axis 
(along 
the side 
axis) 
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iv. You will have to play around with these options to get your desired 

graph look. 
v. Remember that each different graph types have different options, 

but most of them will require an X-axis and Y-axis data.  Also 
remember that the data does not have to be a number field.  They 
can be datetime ranges, grouping fields, etc.  How you group the 
data will effect how the data is displayed.  But the Y-Axis is 
normally a number.  (Hint: If you see a weird graph, then most likely 
you have mixed up the X-Axis and the Y-Axis fields.) 

 
c. The “Text” tab allows you to change the graph title and axis labels. 

Advance
d 
Options 

X-Axis 
Data 

Y-Axis 
Data 
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28. Click “Next>>” button to move to the “Select” tab. 

 

Y-Axis Label 

X-Axis Label 

Graph Title 
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29. “Select” tab allows you to filter the data.  Similar to a SQL “WHERE” clause. 
30. For now, we will leave the “Selection Fields” blank because we will come back to 

this after adding input parameters. 
31. Click “Next>>”, this will bring you to the final “Style” tab. 

 
32. “Style” tab allows you to select how the data will be displayed.  
33. Select a style you like, and then click the “Finish” button. 
34. We are finished using the Report Expert.  Which performs 80% of the hard work.  

The next step will be to move around the columns to exactly how you want to 
display it and adding in input parameters. 

The resulting report from Report Expert Should look something like this: 
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Adding Input Parameters 
Input parameters will prompt the user for more information before running the query.  
For example, this report should prompt the user for a date range to filter by.  
Additionally, the user should specify a ContactID to identify the CustomerID.  The 
WebCenter automatically fills in basic user information, like “ContactID.”  Look into the 
“tww_ReportAutoFillParameter” table for a list of automatically fielded parameters. 
 
To add input parameters to this report do the following: 

1. Click on the “Insert Fields” tool bar button. 

 
2. A “Field Explore” window should pop up. 

+� � � 
 � � , �� �� � �
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3. Select the “Parameter Fields” item and click on the “New” button to create a 

new input parameter. 
4. A “Create Parameter Field” widow will pop up. 

 
5. Type in the parameter name and select a parameter data type.  Do not worry 

about setting default values because the WebCenter will automatically prompt 
the user for any input parameters.  Click “Ok” when you are done. 

6. Repeat steps 3-5 for the following input parameters: “StartDate” (as a datetime), 
“EndDate” (as a datetime), and “ContactID” (as a number). 

7. The “Field Explore” window should have the following input parameter fields: 
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8. Click “Close” to exit the Field Explore window. 
9. Now, we are ready to filter the data from the newly added input parameter. 

Setup Up Selection Filtering 
In this section, we will learn how to filter the data using the input parameter fields. 

1. Click on the “Selection Expert” button in the tool bar. 

 
2. A “Choose Field” window should pop up if you have no fields selected.  

(Otherwise, you will the “Select Expert” window, then go to step 4.) 

 
3. Select the “WeekendBill” field to filter and click the “Ok” button. 
4. A “Select Expert” window will pop up. 
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5. Filter by “Is Between”.  Then select the input parameters from the dropdown 

value list. 
Note: Only input parameters of the same type are displayed in the input 

parameter list. 
6. Click the “New…” button (or select the “ <New>” tab) to add another select filter. 
7. Select the “ContactRoot.ID” field.  Then click “Ok.” 

 
8. Filter by “Is Equal to”.  And select “ContactID” from the input parameter list. 

 
Note: Setting the ContactID will filter all the departments by the customer’s 

parent CustomerID.  Remember that ContactID is automatically provided by 
the WebCenter.  Look into the “tww_ReportAutoFillParameter” table for a list 
of automatically filled parameters. 

Add a new Field to 
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Advance: If you want automatically filled parameters or dropdown lists, please 
put them into the “tww_ReportAutoFillParameter” table.  The table contains 
two fields: ParameterName and ParameterFunction.  ParameterName is the 
name of the parameter in Crystal Reports.  ParameterFunction is the name 
of the function in SQL Server.  All the functions receivers a GUID as an input 
parameter to uniquely identify the user. 

 
9. Click “Ok” to return to the main design window. 
10. Now you are ready to re-run the SQL query with the new input parameters. 

 

Running the SQL Query 
After setting up the input parameters, you should re-run the query to filter the data. 

1. To re-run the query, click the “Refresh” toolbar button. 

 
2. Type in the values for each input parameter.  And then click “Ok.” 

 
3. This should bring you back to the main “Preview” window after the query is done 

running.  The “Preview” screen should look something like this: 

Select an input 
Parameter 

� 
 � � � �� � � 
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Adding Fields to the Report 
After you are done creating a basic report, you might have forgotten to include a field or 
you want to display the input parameter values on the report.  For example, it would be 
nice to display the start and end dates on the report.  To do this: 

1. Make room for the new fields.  The start and end date fields should be place in 
the report header. 

a. Move back to the “Design” view.  
b. Resize the graph to fill the top half of the report. 
c. Move the separation line down so the new fields will fit. 
d. After you are done, it should look like: 
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2. Click on the “Insert Fields” toolbar button again. 

 
3. From the “Field Explore” window, open up the Parameter Fields node to find the 

“StartDate” and “EndDate” input parameters. 

Move 
Separation 
line down 
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4. Drag-n-drop the parameter into the “Design” panel. Do this for both the StartDate 

and EndDate.  Then close down the “Field Explore” window. 
5. The design window will look like this: 

Drag-n-Drop fields or 
parameters into the 
design window 



                                         
(continued) 

 
 

 
© 2005, TempWorks Software, Inc.  All rights reserved Page 28 of 45 

 
6. Move to the Preview screen and it will look like this: 

 
7. Remember that you can also drag-n-drop table fields, formulas, input 

parameters, and more from the “Field Explore” window into the design panel. 
Looking at the “Preview” screen, you notice that the start and end date fields include the 
date and time.  We only want to display the date.  The next section will explain how to 
change the display properties of the cells. 
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Changing Field Properties  

This section will describe how to change the format property of the cell.  
For example, we want to change the format of the date fields of the 
StartDate and EndDate to display just the date.  To do this: 

1. Select the field(s) you want to change.  Right click on the field and 
select the “ Format Objects…”  menu. 

 
2. Select the “ Date/Time”  tab in the “ Format Editor”  window. 

 

. �� � � � � ��� � � � � � � � � �
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3. Select the correct style you want to display. 
4. In the Format Editor, you can change other display property like the 

border. 

 
5. But for this example, do not set any borders for the start and end date 

fields. 
6. Click “ Ok”  when you are done. 
7. Next, we want to add a label to the report that label the start and end 

date fields. 

Adding Labels and Embedding Fields in Labels 
This section will illustrate a few tricks when adding labels.  But first, to add a label: 

1. Click on “Insert Text Object” toolbar button. 

 
2. Drop the new label where you want to place the label in the design window. 



                                         
(continued) 

 
 

 
© 2005, TempWorks Software, Inc.  All rights reserved Page 31 of 45 

 
3. Double click on the label so that you can type in the label.  Type “Weekend Bill 

Date:” into the new label.  Like this: 

 
4. Now you want to embed the StartDate and EndDate fields into the label, so the 

label would look like this, “Weekend Bill Date: [StartDate] to [EndDate].”  To 
embed the field into the label, just drag-n-drop the field into the label.  It should 
look this: 

 
5. Now, type “To” after the “[StartDate]” and drag-n-drop the “EndDate” field into the 

same label box until it looks like this: 

 
6. Move to the Preview screen, and the new label should look something like this: 

 
7. You can reformat the label just like a field by right clicking on the label and 

selecting “Format Text” menu item.  Increase the label font to 15 pt. 
8. Finally, we are ready to edit the display layout. 

# 
 � � � � � � �
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Drag-n-
drop 
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Adding and Removing Grouping Sections 
Some times you would like to add or remove a header / foot from a group, this section 
will show you how to do that.  For this example, the “Detail” section is just too much 
information.  All that needs to be displayed is the departments with its totals.  Thus, the 
group header and details section should be removed.  To do this: 

 
1. Before any sections can be removed, the objects in the sections need to be 

removed.  Select all the objects in the details and group header and click the 
“Delete” key on the keyboard. 

 
2. One way to remove a section is to hide it from view by squishing it height to zero. 

 
3. Before you can do that, you will have to remove the little alignment guides on the 

side of the report.  To remove the alignment guides, click on them and drag them 
off the side of the report.  Now drag the separation lines so the heights of the 
sections are zero.  It should look like this when you are done: 

 

Drag the mouse to 
select all the fields to 
delete. 

� ��� � � � # � �� � � � �
� � 
 � � � � � � � �
� � 
 � � 	 
 � � � � �

Remove alignment guides by dragging them off the side of the 

Squish 
the 
sections 
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4. Or you can delete the sections.  There are two ways you can delete the section.  
One way is to right-clicking in the gray area on the right side of the section and 
select the “Delete Last Line” menu item. (As you can see, you can also insert a 
new section below the current section using this technique; it’s called “Insert 
Line” in the menu.) 

 
5. The other way to insert and delete sections are by using the “Section Expert.”  

Click on the “Section Expert” toolbar button. 

 
6. A “Section Expert” window will pop up. 

Right Click 
Here 
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7. Besides inserting and deleting sections, the section expert allows you to change 

the section properties.  It seem that you can’t delete the Details or Group header, 
from this report.  So just squish the details and group header file to have zero 
height. 

You are almost done with the report.  Move around the fields and change its display 
properties so the designer screen looks like this: 
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You might wonder where the “Page N of M” on the lower right side of the page came 
from.  It is a special report field.  You would add it just like any other field.  Click on 
“Insert Fields” toolbar button.  A “Field Expore” window will pop up.  Expand the 
“ Special Fields” node.  Drag-n-drop “Page N of M” into the “Design” window. 

 
 
The full report preview screen should look like this: 
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For most people, this report would be done.  But pretend you would like the report to 
display the average pay rate for each department.  The next section will illustrate how to 
add formula fields into the report. 
 

Adding a Formula Field 
This section will show how to create a new field that performs some calculations. 

1. Click on the “Insert Fields” toolbar button to bring up the “Field Explore” window. 
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2. Select the “Formula Fields” and click the “New” button to create a new formula 

field. 

 
3. Type in a new formula name like “AvgPayRate.”  Click “Ok.” 
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4. Now a “Formula Editor” window should pop up.  This window allows you to 

construct any kind of function you want.  You do not have to know how to write in 
Crystal Report formula editor to use it.  It is actually very easy, just double click 
on a field, function, or operation list item and the editor will dump out the correct 
syntax to the expression panel. 

5. To create the average pay rate for each department, you will: 
a. Click on the Report Field->”Group #1: TxnsRoot…TotalBill” 
b. Click on the Operations->Arithmetic->”Divide” 
c. Click on the Report Field->”Group #1: TxnsRoot…THours” 

6. This should create a expression that looks like this: 
Sum ({ TxnsRoot.TotalBill} , { TxnsRoot.DepartmentName} ) / Sum ({ TxnsRoot.THours} , 
{ TxnsRoot.DepartmentName} ) 
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7. Now click the “Check” button to check if the expression is correct.  Then click the 

“Save and Close” button to save the expression and close the window. 
8. Drag-n-drop the new formula field into the design window.  And add a label for 

the new field.  It should look like this: 

3 

1 

 2 

. � � � �� �� � �
/ � � 
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Save and 

Check Syntax 
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9. The preview window will look like this: 

Drag-n-drop 
the new 
formula field. 
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10. Finally the report is done.  For completeness, you can add another formula field 

to the report that calculates the average pay rate for the whole company.  But 
this exercise you should try out for yourself. 

Now you should save this report.  The next section will provide some helpful tips 
when saving Crystal Reports. 
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Saving Crystal Reports 
When saving a Crystal Report, remember not to save the data with the crystal report.  If 
the data is saved with the report, then it will take longer for the Crystal Report to upload 
up in the WebClient.  By default, Crystal Report always saves the data with the Crystal 
Report.  Make sure the “File->Save Data with Report” item in the main menu is 
unchecked. 
 
Change from: 

 
 
to: 
 

 
 
One more thing, try to save the Crystal Report name without any spaces.  For example, 
save this report as “SpendingByDepartment.rpt”. 
 
Once you have saved the report, you might want to test this report with another 
database.  The next section will illustrate how to change the database connection.   

Changing the Database Connection 
A common thing you might want to do is test the report with data from another 
database.  It would be inefficient the recreate the report just to change the database 
connection, so Crystal Reports provides a way for you to change the database 
connection. 

1. To change the database connection, go to “Database>Set Location…” in the 
main menu. 
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2. A “Set Location” window should pop up. 

 
3. Select the tablename or stored procedure from the list box.  Then click on the 

“Set Location…” button for that tablename. 
4. A “Data Explore” window should popup. 

DNS Name 

Database 

Select 
Tablename 

To change 
location 
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5. Find the same tablename in the new database.  Select the new table location 

and click the “Set” button. 
6. It will ask you if you want to set this change for the rest of the tables, and click 

“Yes”. 
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7. Check the “Server Name” and the “Database” to make sure the new changes 

were applied. 
8. Click “Done” to return back to return to the main design window. 
9. You might get a prompt to verify the changes.  Just click “Ok.”  (If the new table 

does not contain the same information as the original database.  You might have 
to manually remap the fields.) 

 
10. Now, click the “Refresh” toolbar button to requery the data. 
 

Summary 
This documentation covered the basics for creating a new Crystal Reports.  Most of the 
report can be created using the Report Expert.  Remember to try to do all the data 
shaping within Crystal Reports to minimize the amount of files to keep track of.  After 
creating the report, use the Reports Admin pages of the WebCenter to upload the report 
to WebCenter. (See Uploading Reports to WebCenter documentation.)  Finally, 
remember that anything you can do in an Access report you can do in Crystal Reports. 
 
 

Confirm 
Changes 


